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Before you begin...
It is recommended that the following items be available to make this short step-by-step 
introduction to the Productivity®2000 System go smoothly.

P2 CPU Module

Productivity Suite 
Programming Software 

PS-PGMSW

Screwdriver 
TW-SD-MSL-1

USB-A to Micro USB-B 
Programming Cable 

PC Running 
Windows OS

Hookup Wire
AC Power Cord

P2-01AC Power 
Supply

Productivity®2000 System Example

Wire Strippers 
DN-WS

Not available from 
Automationdirect.com

P2-Fill Module

P2-08SIM Module

P2-04B Base

P2-08TRS Output Module

Download software from our webste 
at: www.automationdirect.com under 

“Productivity Suite”.

Not available from 
Automationdirect.com.

http://cdn.automationdirect.com/static/manuals/p2userm/p2userm.html
https://www.automationdirect.com/support/software-downloads#main-content
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Productivity Suite System Requirements

Productivity Suite, a Windows-based programming software, is available as a FREE 
download at https://www.automationdirect.com/support/software-downloads#main-
content.  Please check our website for your product’s current operating systems 
requirements.  

NOTE: USB or Ethernet cable is also required for communications between PC and CPU.

http://cdn.automationdirect.com/static/manuals/p2userm/p2userm.html
https://www.automationdirect.com/support/software-downloads#main-content.
https://www.automationdirect.com/support/software-downloads#main-content.
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Step 1: Install Programming Software

�Download the latest version of the Productivity Suite Programming Software 
from the Automationdirect website, or insert the Productivity Suite 
Programming Software USB thumb drive into your PC USB port.

2.	 By default Productivity Suite will be saved in the “Download” folder as a “.zip” file. 
Right Click on the ProSuite_xxx.zip file in the Download folder. 
Choose “Extract All” from the drop-down menu. A popup box will open. 
Select the “Browse” button and navigate to the folder where you prefer to store the 
program.  
Click on “Select Folder” button and in the next box choose “Extract”.

NOTE: See the Productivity Suite Installation and Productivity Suite Startup topics for additional 
details if needed.

3.	 Navigate to the choosen folder and double click on the ProSuite “.exe” file. 

4.	 The “Setup Wizard” window (shown below) will appear.  Select Next. 

http://cdn.automationdirect.com/static/manuals/p2userm/p2userm.html
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5.	 Carefully read the software license agreement.  If you agree to the 
terms and conditions of this agreement, select the “I accept the 
terms of the License Agreement” and then the “Next” button. 

6.  �The “Destination Folder” window will open next. The default loaction will 
appear in the text box: C:\Program Files\AutomationDirect\Productivity 
Suite <Software Version>.  Should you desire a different folder choose: 
a.	 Browse: This option allows you to select another folder for installation. 

If the installer detects a previous version of Productivity Suite on your PC, there is 
another option available with this window:

b.	 Replace Existing Instance:  This option allows you to uninstall 
the previous version of the software and install the new version 
in its place.  If you check this option, select the version in the 
window that you want to delete.  Click “Next” to continue.

http://cdn.automationdirect.com/static/manuals/p2userm/p2userm.html
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7.  �Once you have selected the install folder or after deleting any 
previous instances, click “Install” to begin the installation.

A status window will appear displaying the status of the installation.  

A shortcut icon will automatically be placed on the Desktop during installation. 

http://cdn.automationdirect.com/static/manuals/p2userm/p2userm.html
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8.  �The next screen to appear contains the Release Notes for this version of the 
Productivity Suite software.  This is an opportunity to review the software version 
release notes.  You may read these before selecting the “Next” button.

9.  �The Installation is now complete.  Select “Done”.

http://cdn.automationdirect.com/static/manuals/p2userm/p2userm.html
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Step 2: Launch Programming Software
After installing the Productivity Suite Programming Software, PS-PGMSW, launch the 
software by double clicking the desktop Productivity Suite Icon.  Or from the PC’s ‘Start’ 
menu, select Productivity Suite x.x.x.x.

The Productivity Suite Programming Software will start up and display the Main Window 
as shown below.

NOTE: The minimum supported screen size for the Productivity Suite Software is 1920 X 1080 
pixels. 

Click on the ‘Start a New Project’ in the Start Productivity dialog box to open a 
programming window.

http://cdn.automationdirect.com/static/manuals/p2userm/p2userm.html
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The Programming Window is divided into menus and toolbars that work together to make 
project development as simple as possible.

Online Help
It is essential that you use the Productivity Suite online Help to familiarize yourself with the 
software.  Keep it open on your desktop and refer to it frequently as you build your system. 
Click on the toolbar Help button to open the Help file.

http://cdn.automationdirect.com/static/manuals/p2userm/p2userm.html
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Step 3: Install Hardware
The Productivity®2000 CPU system components snap together to form a configured CPU 
in minutes.  See Chapter 5, Installation and Wiring, for more detailed hardware installation 
information.  What follows are the basic steps:

1. Install power supply in the base and engage locking tab.

2. Install CPU in the base and engage locking tab.

Locked

http://cdn.automationdirect.com/static/manuals/p2userm/p2userm.html
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3. Install I/O Modules and engage locking tabs.

4. Connect appropriate wiring to the power supply (P2-01AC) and I/O (P2-08TRS 
module) in this example.

Locked Unlocked

� � � � � 3 � 2 3
� � � � � over
� � � � � 2 � 3 2
� � � � � � � � � �

�� � � � 41 � 5 4
� � � � � 3 � 2 3
� � � � � 7 � 2 3
� � � � � under
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GND

LOGIC
GND
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AC(

LO
GN
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GN
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Power Supply

(L)

(N)

GIC
D

D

GIC

D

wer SupplyS l
Load

ACLTo Load

The power supply and load 
are connected through an 

AC current source.
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5. Connect USB cable. Programming connections may be via Ethernet cable or USB. 
P2-622 CPUs have a USB type C programming port and P2-550 CPUs have a microUSB 
type B port. 

http://cdn.automationdirect.com/static/manuals/p2userm/p2userm.html
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Step 4: Apply Power to CPU
Ensure proper wiring and the correct voltage is available before connecting wiring to the 
power supply.  Once this is verified, connect power to the power supply.  Once power is 
applied, the CPU will perform a self evaluation and verification.  See Chapters 2 and 5 of 
this manual for more power supply and input wiring information.

AC(L)

AC(N)

GND

LOGIC
GND

P2-01AC

P2-01DCAC

100-240 VAC

P2-01DC: 24–48 VDC

P2-02DC: 24VDC

P2-01AC

AC(L)

AC(N)

GND

LOGIC
GND

P2-01AC

+V

-V

GND

LOGIC
GND

P2-01DC

P2-01AC

P2-01DC

ACL

ACN

GND

LOGIC
GND

P2-01DCAC

12-24VDC 24VAC

+V

-V

GND

LOGIC
GND

12–24 VDC 24VAC

P2-01DC

+V

-V

24-48VDC
30W

P2-01DC

AC(L)

AC(N)

GND

LOGIC
GND

P2-01DC

P2-02DC

+V

-V

24VDC
50W

P2-02DC

+V

-V

GND

LOGIC
GND

P2-02DCP2-02DC
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Step 5: Establish PC to CPU Communications
Select “Choose CPU” icon on the CPU Toolbar and the dialog box shown below will appear.
Highlight the installed CPU listed in the dialog box and select “Connect”. 

When initially going Online with the CPU, a popup window will notify you of a project 
difference between the CPU and the PC.  Select “No, Use PC Project” command button.

http://cdn.automationdirect.com/static/manuals/p2userm/p2userm.html
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Step 6: Open/Read Hardware Configuration
Before we create a project we must configure the hardware so we’ll have default input 
and output tags for use in our project.  With the CPU in “STOP” Mode, select Hardware 
Configuration under Application Tools  and the following screen opens.

http://cdn.automationdirect.com/static/manuals/p2userm/p2userm.html
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This screen shows the user tag names for all sixteen I/O points.  Select “OK”.

http://cdn.automationdirect.com/static/manuals/p2userm/p2userm.html
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Step 7: Create a Project
We’re going to start by entering a simple ladder logic program in the order that follows.
Rung #1
Select the “END” position on Rung #1 with your cursor.  From the Instruction List on the 
right, scroll down to Counters/Timers section and double click on the Simple Timer (STMR) 
instruction.  The “Simple Timer” instruction automatically is placed on the selected rung 
and the Simple Timer (STMR) dialog box pops up.
Enter ‘T1_SP’ into the Preset Value field. 
Enter ‘T1_CURVAL’ into the Current Value field.
Enter ‘T1_DN’ into the Done field. 
Select “OK”.  

The Define Tags dialog box opens. Select OK.
Enter preset time value of 300ms into “Initial Value” field for Tag T1_SP.

http://cdn.automationdirect.com/static/manuals/p2userm/p2userm.html
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Place the cursor on the first position on Rung #1 as shown below.  In the Instruction List 
on the right, scroll up to Contacts section and double click on “NO Contact (NO)”.  A NO 
Contact (NO) is placed at this rung position and a dialog box pops up. 

Enter ‘T1_Start’ into the text box.
Select OK.

The Define Tags dialog box opens.  Select “OK”.

http://cdn.automationdirect.com/static/manuals/p2userm/p2userm.html
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With the cursor on Rung #1, to the right of contact ‘T1_Start’, we are going to begin 
drawing a branch circuit.  Under the Edit drop down menu, select “Wire”, then select 
“Down”.  Notice that a wire has been added.

NOTE: THERE IS ALSO A WIRE ERASE WITH CURSOR TOOL IN THE EDIT DROP DOWN MENU THAT IS 
USED TO ERASE ANY LINES THAT WERE CREATED USING THE WIRE TOOLS.

http://cdn.automationdirect.com/static/manuals/p2userm/p2userm.html
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Next we’ll draw a wire to the left.  Under the Edit drop down menu, select “Wire”, then select 
“Left”.

Next we’ll add another normally-open contact.  Place the box cursor on the first position on 
the newly created SubRung #1.  From the Instruction List click & drag a Contact (NO) into 
this box.  A NO Contact (NO) dialog box pops up. 
Enter ‘T1_Manual’ into the field.
Select “OK”.

The Define Tags dialog box opens. Select “OK”.

http://cdn.automationdirect.com/static/manuals/p2userm/p2userm.html
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Rung #2
Next we’ll add another normally-open contact at the start of Rung #2.  Click & drag a “NO 
Contact (NO)” into this box.  A NO Contact (NO) dialog box pops up. 

In the empty tag field press the down arrow on the right to open 
a drop-down list; scroll down and select ‘T1_DN’.

Select “OK”.
Next we’ll add an Out coil at the end of the rung.  Place the cursor at the end of the rung.   
From the Instructions list Coil section, double click on an “Out Coil (OUT)”.  An Out Coil 
(OUT) is placed on the rung and a dialog box pops up.

In the tag field press the down arrow on the right to open a drop-
down list; scroll down and select ‘DO-0.1.2.1’.

Select OK.

http://cdn.automationdirect.com/static/manuals/p2userm/p2userm.html
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The ladder program now looks like this.  When either of the T1 contacts are energized, the 
timer starts.  When it times out, contact T1_DN energizes and turns on the rung 2 output.

http://cdn.automationdirect.com/static/manuals/p2userm/p2userm.html
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Step 8: Save Project
Save the project by opening the File drop-down menu and selecting Save Project.

http://cdn.automationdirect.com/static/manuals/p2userm/p2userm.html
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Step 9: Write Project to CPU
Next we will transfer the project to the CPU.  Transfer Project is accessed by selecting 
Transfer Project from the File Menu.  
Select “To CPU” from the Transfer Project menu. 

The project will then be Transferred to the CPU from the PC.  During the transfer a status 
window will open displaying the process.

http://cdn.automationdirect.com/static/manuals/p2userm/p2userm.html


Chapter 1: Getting Started

1–25Hardware User Manual, 3rd Ed. Rev. KProductivity2000

Step 10: Place CPU in RUN Mode
Next, verify the Run/Stop switch on the CPU faceplate is placed in the Run position and 
then place the CPU in RUN mode on the Productivity Software Toolbar so the ladder logic 
program executes.

NOTE:  If the Run/Stop switch on the CPU is in the Stop position, the Run button on the 
Programming Software Toolbar will be disabled.

http://cdn.automationdirect.com/static/manuals/p2userm/p2userm.html
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Step 11: Test the Project Using Monitor Mode or 
Simulator

In this next step, use the Monitor Mode and Data View to test the ladder logic program.  

Select Monitor Mode from the top of the Ladder Logic screen to display the status of 
Boolean and Integer Tags.
Using Data View, the Tag values can be viewed or manipulated for testing the project.  The 
Data View window can be accessed by selecting Data View from the Tools Menu of the 
Main Menu.
For the Simple Timer Instruction, a Monitor button is provided that, when selected, will 
load the tags associated with the instruction into Data View. 

http://cdn.automationdirect.com/static/manuals/p2userm/p2userm.html
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The tags will be placed in a separate Tab titled New Task - STMR as seen below. 

The remaining tagnames in the Ladder Logic can be added to the Data View window by 
clicking on a blank area in the Tagname column.  This will display a drop down menu where 
the tags can be selected.  Scroll down the list and select the tags to be added.

http://cdn.automationdirect.com/static/manuals/p2userm/p2userm.html
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Once all of the tagnames have been added, they can now be monitored and manipulated.  
See the Data View help file topic for additional details if needed.

NOTE: Force must be enabled for a Tag in the Tag Database before Force can be used in Data 
View.

http://cdn.automationdirect.com/static/manuals/p2userm/p2userm.html
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